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Welcome to OrderGen 1.0, purchase order generating software for Windows(TM).    OrderGen is designed 
to coordinate all relevant information for generating purchase orders for new or existing vendors.    The 
purchase order database maintains current and historical information about all generated purchase 
orders.

This context-sensitive help system will describe the operation of the system and provide useful hints and 
answers.    Use the browse buttons ("<<" and    ">>") above to move through the help system topic-by-
topic.    Within the OrderGen program, the user can obtain help on the current OrderGen topic at any time 
by pressing and holding the "Ctrl" key, and then pressing the "F" key (Ctrl F).
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New Data      

A new data entry session is started by selecting the "Data" menu and selecting "New...".    The radiogroup 
showing    "New Vendor", "New Purchase Order", and "New Recipient" appears.    

New Vendor

To add a new vendor, select "New Vendor", and click "OK".    The "New Vendor" form, illustrated below, 
appears requesting company name, address, and related information.

After entering the requested information, click "ADD VENDOR".    Additional vendors can then be added.   
Click "CLOSE" after adding all vendors.

Adding a New Purchase Order

Select "New Purchase Order" and click "OK".    A form resembling the following appears.



The Vendor Name field is a listbox, from which the user must select the name of an existing company in 
the vendor database.    If "Automatic P O Number" is selected in the "Options" menu, a unique purchase 
order number will be assigned as soon as the Vendor Name is selected.    The structure of an 
automatically generated Purchase Order Number is:    AAA-mmddyy-NN.    The user can override the 
automatically generated number and enter his/her own purchase order number by unchecking "Automatic
P O Number"    in the "Options" menu; note, however, that Purchase Order Numbers must always be 
unique!

An unlimited number of items can be added to the purchase order by entering the required information, 
and clicking "ADD ITEM". When all items for the current purchase order have been entered, click 
"FINISH".    A form appears requesting the name of the recipient for the current purchase order.    Select a 
recipient and click "OK".

New Recipient

A new recipient can be added to the employee database by selecting "Add New Recipient" and clicking 
"OK".    Once this is done, the "New Recipient" form appears.    The "New Recipient" form allows the user 
to input company employees who will be generating purchase orders.    After entering an authorized 
employee name, click "ADD EMPLOYEE".    Click "MORE" to add (an) additional name(s).    Click 
"CLOSE" after all names have been added.





Edit (View) Data    

Data in any of the databases can be viewed by selecting the "Data" menu and selecting "Open...".    On 
the form containing the radiogroup shown above, select one of "Vendor Database", "P O Database", or 
"Recipient Database".

Editing an Existing Purchase Order

Select "P O Database" and click "OK".    The "P O Database" form appears.    The "Purchase Order 
Number" field is a listbox, from which the user must select the number for the purchase order to view 
and/or modify.

Note that neither the "Purchase Order Number" nor the "Vendor Name" can be edited.    The user can edit
any of the items in the purchase order, and can scroll through all of the purchase order items by clicking 
the "<" and ">" buttons.    After changing any of the characteristics of a purchase order item, click 
"UPDATE ITEM" to save it to the database.    Click "CLOSE" when all items have been updated 
satisfactorily.

Editing Vendor Information



Clicking the "LOCATE" button selects the "Vendor Name" listbox from which the user can select the name
of the company to change.    The "Vendor Name" cannot be edited.    To change the name of a vendor, use
"New Vendor", and delete the old vendor name.    If there are existing purchase orders under the old 
vendor name, it is suggested that the old vendor name NOT be deleted.    

Any of the other information associated with the vendor can be changed.    Once changes are made, click 
"CHANGE".    Information on other vendors can be viewed and/or changed; click "CLOSE" when finished 
editing.

Viewing Authorized Employee List

Authorized employees can be viewed, but not edited.    If an employee's name is misspelled, use "Delete 
Recipient" and "New Recipient".
 



Data Deletion    

The user can delete any of the data from the database.    Because OrderGen maintains history 
information about all purchase orders generated by the system, it is recommended that data be deleted 
only in cases of incorrect entry, and before any purchase orders which use any of the given data have 
actually been submitted to a vendor.

Deleting a Recipient (Employee)

Select "Delete Recipient" from the above pictured radiogroup on the "Delete Data"    form.    The following 
form appears.

Click on the "< PREVIOUS" or "NEXT >" to move to the employee name to delete.    Click the "X 
EMPLOYEE" button.    Note: "X EMPLOYEE" means to delete this employee from the authorized recipient
list.    It is not meant to imply that the employee is no longer with the user's company, although this could 
very well be the case.

Deleting a Purchase Order

If it is decided not to submit a purchase order, it should be deleted from the database.    Select "Delete 
Purchase Order" and click "OK".    The form resembling the one below appears.



    

Select the desired "Purchase Order Number" from the listbox of the same name above.    At this point the 
user can either delete the currently shown item, or the entire purchase order, by clicking "DELETE ITEM" 
or "DELETE PO", respectively.    A dialog message box appears, requesting confirmation before any 
deletion occurs.    Click "Yes" to confirm "No" to reconsider.

Delete Vendor

If it is decided not to do business with a vendor in the database AND there are no existing purchase 
orders in the database for this vendor, the vendor can be deleted.    Select "Delete Vendor" in the 
radiogroup and click "OK".    The "Delete Vendor" form below appears.

Select the company name from the "Vendor Name" listbox on the form and click "Delete Vendor".    A 
dialog message box appears, requesting confirmation before any deletion occurs.    Click "Yes" to confirm 



"No" to reconsider.    Click "CLOSE" after deleting.



Creating a Purchase Order
The creation of a new purchase, order is quite simple, and requires the existence of the following three 
data in the OrderGen databases:

1) User Company Data

2) Employee to receive order at user's company

3) Data on the vendor to which the purchase order will be submitted.

Additionally, user will need to:

4) Have knowledge of the items to purchase:

a) Name and/or Item Part Number
b) Item Description
c) Item cost per unit
d) Whether the item is taxable

5) Enter the data in "New Purchase Order" mode.



Printing a Purchase Order    

NOTE: The "Purchase Order" form must be in view to print.    There are two scenarios.

1) Purchase Order Not In View
Select "Data" and select "Print...".      A dialog message box appears to confirm that printing is desired. 
Click "Yes".    The "Purchase Order" form, as shown below, appears.    The purchase order form is 
printed.

2) Purchase Order In View
Select "Form" and select "Print".    The purchase order form is printed.



Customized Purchase Order
A user can customize purchase for her/his business by registering this a copy of OrderGen, and by 
sending their company logo and letterhead to Applied Analytic Systems to be embedded into a 
customized purchase order report.

The registered version of OrderGen includes the runtime dll of one of the premier well known reporting 
tools.    Reports for each business owned by the registered user can be created (by Applied Analytic 
Systems) for use by the registered company.    There is no additional charge if the logo(s) and 
letterhead(s) are provided on diskette in a popular graphic image format.    The camera-ready artwork 
used to create the letterhead originally is ideal for this purpose.    If the user does not have camera-ready
artwork, AAS can scan the information into the report.    The cost for this additional requirement is $20 
per scanned report created. 

In addition, Applied Analytic Systems will supply the database table formats allowing the user to create 
his/her own reports at the users request.    OrderGen uses Paradox tables, compatible with various 
report writing tools such as Crystal Reports, ReportSmith, and Paradox for Windows.    The user must be
a registered owner of the developmental version of one of these tools to create his/her own reports.



Shareware Registration
OrderGen is shareware which must be registered with Applied Analytic Systems for continued usage.    
The registered version includes the run-time version of a well-known report engine, a series of blank 
purchase order form reports which can printed on company stationary.    Optionally, a registered user can 
obtain a version with the user's company letterhead(s) embedded into the report.    This allows users to 
FAX purchase orders directly from their computers to vendor sites.

The cost for registration of OrderGen is $25 US or $35 Canadian.    There is no additional charge for 
inclusion of a customized letterhead-enabled purchase order form IF camera ready artwork for the user's 
letterhead is supplied on diskette in CorelDraw (CDR), Windows Bitmap (BMP) or TIF file format.    
Otherwise, AAS will scan your letterhead to obtain the artwork at an additional cost of $20 US ($27.50 
Canadian) per letterhead.    Registered users can obtain OrderGen with a different purchase order form 
for each of their company names (DBAs).

To register, click here to print the registration form.    Complete the registration information, make check 
payable in US dollars to Applied Analytic Systems, Inc., and mail to Applied Analytic Systems' Pittsburgh 
address.    The latest version will be sent on diskette by U.S. First Class mail to the address specified on 
the registration form.    There are no shipping charges.    

Registration Information

Users Name _________________________________________
Company Name ______________________________________
Company Address ____________________________________
City ____________________    State or Province ____________
Postal / Zip Code _____________________________________
Country _____________________________________________
Phone Number _______________________________________
FAX Number _________________________________________
Internet E-Mail Address ________________________________
Web Page ___________________________________________
From Where was OrderGen 1.01 obtained? ________________
____________________________________________________
Comments    __________________________________________
____________________________________________________
____________________________________________________



Applied Analytic Systems
Carnegie Office Park
P O Drawer 3562
Pittsburgh,    PA    15230

E-Mail: aascorp@aol.com
70651.1370@compuserve.com



Menus

Click on one of the items below for a detailed description of the menu items.

Data (or Form)
Options
View
Help



Data Menu

Note: The speedbuttons shown are equivalent shortcuts to the menu command.

New...    

The "New..." menu item opens a dialog box which allows users to select one of :

  
Select "New Vendor" to open a form in which to add company information (name, address, zip) about a 
vendor with which the user's company intends to do business.

Selecting "New Purchase Order" opens a form for data entry which will generate the new purchase order. 
If the "Automatic P O Number" menu item is checked in the "Options" menu, a new Purchase Order 
Number will be created when the vendor's company name is selected.

A "New Recipient" is an employee at the user's organization who is authorized to generate purchase 
orders and receive merchandise at the company.    A form requesting the new recipient name appears
when "New Recipient" is selected.

Open... 

The "Open..." menu item opens a dialog box allowing the user to select from the following radiogroup:

Select "Vendor Database" to view and/or edit its contents. 

The user can view and edit the Purchase Order Database by selecting "P O Database" from the 



radiogroup.

The authorized employee Recipient Database can be viewed (only) by selecting "Recipient Database".

Delete...    

The user can delete items from the various databases by selecting the "Delete..." menu item

Select "Delete Vendor" to remove a company from the Vendor Database.

Delete an existing (but un-submitted) purchase order from the P O Database by selecting "Delete 
Purchase Order".

Select "Delete Recipient" to remove an employee from the database.

Print Setup...

Opens a dialog box which allows user to establish the printer to use, and printer layout.    This option 
may not be active in the unregistered shareware version.    In such a case, user will need to setup printer
from the Windows Control Panel.

Print...    

If the "Purchase Order"    form is open, this option prints to the selected printer or fax port.    Otherwise, the
user is prompted to open the "Purchase Order" form, or to cancel the print job.

Exit      

This will exit OrderGen subject to the value of the "Backup When Exiting" menu item in the "Options" 
menu.      If "Backup When Exiting" is selected, session files will be saved and backed up, otherwise 
session files will be saved only.



Options Menu

Set Company Information...

This opens a form on which the user can enter address and phone information about her/his company
which will appear on the finished purchase order.    Only one company name is supported in the 
shareware version.

Backup When Exiting

When this option is checked, backup version of session files will be saved in "ordergen.bak".    This 
allows recovery if session files are corrupted by power failure, system crash, or other unexpected 
occurrence.

Automatic PO Number

When this option is checked, an automatic purchase order number in the form AAA-mmddyy-NN will 
be assigned whenever a new purchase order is created.    Users can use their own purchase order 
numbering system; however, they will need to uncheck this option, and enter purchase order numbers
manually.

Statusbar Quick Guide

When this option is checked, the Quick Guide tutorial will be repeatedly displayed on the statusbar at 
the bottom of the screen.    The steps are numbered, and the next step in generating a purchase order
is displayed approximately every 5 seconds.



Quick Guide
QUICK GUIDE TO ORDERGEN 1.0:

The Quick Guide is an automated tutorial of the OrderGen usage.    It shows the 11 essential steps to 
generate the first purchase order.    This information is displayed repeatedly on the statusbar on the main 
form.

1) Add your Company Information:
a] Select "Options", "Set Company Information"
b] Add your company name and address

2) Add to the Vendor Database:
a] Select "Data", "New..." or click "+ Folder" speedbutton
b] Select "New Vendor" and click OK
c] Add vendor name and address information

3) Add a new Purchase Order:
a] Select "Data", "New..." or click "+ Folder" speedbutton
b] Select "New Purchase Order" and click OK
c] Select the "Vendor Name" and add new items



View Menu

Current Purchase Order      

This shows the "Purchase Order" form for the most recently selected purchase order.

Purchase Order History

Selecting    "Purchase Order History" opens the "History" form showing each purchase order number,  
corresponding vendor name, and the order recipient.

Free Memory

When "Free Memory" is checked, the statusbar will show the amount of system free memory 
whenever "Quick Guide" is turned off in the "Options" menu.



Help Menu

Contents

This takes the user to the Contents section of this help file.

This Form

This is the context sensitive menu entry.    The user will be transferred to the help topic most relevant 
to the task s/he is currently attempting to perform.    The user can also use "Ctrl F".

Search for Help On...

This allows the user to search this help system by keywords.    This is equivalent to clicking the 
"Search" button above.

How to Use Help

This opens the designated WinHelp file for explaining the use of Windows help.

About Applied Analytic Systems

Opens a form within OrderGen which provides information about Applied Analytic Systems, Inc.

About OrderGen

Opens a form showing the OrderGen version and copyright information.

Registration

Shows current information within the help file on shareware registration or commercial licensing.



AAA-mmddyy-NN

AAA is an abbreviation for the company name, which is usually the initials for the company.

mmddyy is the current date: mm is the month number, dd is the day number, and yy is the year number.

NN is an integer equaling 1+ the number of items which are in the P O database. 



Crystal Reports

Crystal Reports is a registered trademark of Seagate Software Information Systems, Inc.



ReportSmith

ReportSmith is a registered trademark of Borland International, Inc.



Paradox

Paradox is a registered trademark of Borland International, Inc.



Post Installation

Necessary Runtime Modules

Shareware version of OrderGen includes the following runtime files:

1) VISION.EXE    (ObjectVision 2.1) Borland International
2) PXENGWIN.DLL (Paradox Engine) Borland International
3) BWCC.DLL (Windows Custom Control) Borland International
4) OVEXTRAS.DLL (ObjectVision Extension) R. Scott McKinney
5) TREESURG.DLL (Tree Surgeon 2.1) T.J. Techniques Ltd. 

System Requirements

1) 386, 486, Pentium with 4 MB RAM
2) Windows 3.1x, 95 or NT
3) 2.5 Meg available Hard Disk space
4) SHARE.EXE (in Windows 3.1x)

5) Running SHARE.EXE (only applies to Windows 3.1x)
      -----------

Unless the "device=vshare.exe" command is in the [386Enh] section of the user's system.ini file, the 
DOS share.exe program MUST be loaded BEFORE Windows is started.    Add the SHARE command 
to the autoexec.bat file anywhere preceding the line containing the WIN command.

 Example:
      autoexec line 1
      autoexec line 2
          .
          .
          .
      autoexec line n
      SHARE
      WIN

Or run share (manually) before running Windows as follows:
    
    C:\>share                (typed by user at c: prompt)
    SHARE installed    (dos system message)
    C:\>win                    (typed by user at c: prompt)

Share is usually in the DOS directory, and DOS should be in the path. If DOS is not in the path, type

    C:\somedir>CD\DOS622    (get into the DOS directory)
    C:\DOS622>share              (typed by user at c: prompt)
    SHARE installed              (dos system message)
    C:\DOS622>win                  (typed by user at c: prompt)

6) STARTUP    - Installation Directory
      ---------



The target directory for the installation is "c:\visionr". This is the recommended drive and directory 
name for the installation.    During installation, the user is allowed to change the target drive and 
directory names.

Do not change the name of the installation directory at any time AFTER installation has been 
completed.



Registration Information

ORDERGEN 1.0
Rev. 1
July, 1996

Mail To: 

Applied Analytic Systems
Carnegie Office Park
P O Drawer 3562
Pittsburgh,    PA    15230

Users Name _________________________________________
Company Name ______________________________________
Company Address ____________________________________
City ____________________    State or Province ____________
Postal / Zip Code _____________________________________
Country _____________________________________________
Phone Number _______________________________________
FAX Number _________________________________________
Internet E-Mail Address ________________________________
Web Page ___________________________________________
From Where was OrderGen 1.01 obtained? ________________
____________________________________________________
Comments    __________________________________________
____________________________________________________
____________________________________________________



SHARE

SHARE.EXE is used in a multi-tasking environment (Windows) in which programs share files.    Share 
loads code into memory that supports file sharing and locking.    Once share is installed, MSDOS uses 
the code loaded by Share to validate all read and write requests from programs.    The Paradox Engine 
uses share for database access control.






